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1 Introduction

Welcome to MacWAIS.  This chapter briefly tells you what MacWAIS is, what 
equipment you need to run it, and what information is covered in the remainder of 
this manual.

MacWAIS – What is it?
MacWAIS is an application that allows you to find, retrieve, and intelligently 
process information via the WAIS protocol.  MacWAIS is also EINet-
authentication savvy, so it is capable of communicating with EINet-secured WAIS 
servers.  (See EINet Manager for the Macintosh User Manual for more details on 
EINet authentication.)1

What is needed to run MacWAIS?
MacWAIS is intended to run on all Macintosh platforms.  It is recommended that 
you run MacWAIS with at least 4M RAM.  Because MacWAIS is a TCP/IP-based 
network application, it also requires MacTCP 1.1 or newer.

How much disk space?
The distribution, MacWAIS1.29.SEA, is a self-extracting Compact Pro™ 
archive that contains the following:

• two README files:  one named README (which provides information 
about the current release), and the other README.shareware (which 
provides legal/license information),

• the MacWAIS application, MacWAIS,
• a WAIS Question entitled EINet Shareware (that’ll get you 

information about shareware available from EINet),
• the User Manual you’re currently reading(MacWAIS User Manual), as

well as a text-only version (MacWAIS User Manual (text)),
• a folder named wais-sources, that contains the following two Source 

files:  Directory of Servers and EINet Directory of 
Servers.

MacWAIS1.29.SEA is 325K2 in size.  When extracted and decompressed, 
MacWAIS (383K), README.EINet (.5K), and the wais-sources folder and 
its contents (3K) take up ~387K on your disk.  This total does not reflect the 
Preferences File, or retrieved Source or Document files created as part of 
MacWAIS’s execution.

1The shareware version of MacWAIS is not EINet-authentication savvy.  The secure version of MacWAIS and 
EINet Manager for the Macintosh are available exclusively to EINet customers.
2These file sizes are approximate in nature, and apply only to the secure version of MacWAIS.
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Which System/Finder?
Use the latest System and Finder provided by Apple.  MacWAIS requires at least 
System 6.0.7.  Certain features of MacWAIS are System 7-specific (e.g., Document
launching).  On non-System 7 platforms these features are simply not invokeable.

What’s in the rest of this Manual?
The remainder of this manual provides:

• a brief overview of WAIS and the part MacWAIS plays within it,
• instructions for installing MacWAIS, and, finally,
• detailed descriptions of all of the MacWAIS commands.
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2 Overview
Wide Area Information Servers, or WAIS, contains three basic parts:

• servers – the indexers and retrievers of sets of information (referred to as 
Sources),

• clients – the user’s front-end for querying the Apr 18, 2021information 
fronted by servers (i.e., “asking” Questions), and

• a standard protocol (Z39.50) – the mechanism through which clients and 
servers communicate.

How does MacWAIS fit in?
MacWAIS is just one of several WAIS client programs that are available.  Few, 
however, run on the Macintosh.  And none, except MacWAIS, combine Document 
launching (i.e., the ability to invoke a particular program based on the WAIS type 
of the Document being retrieved) and the ability to communicate with secure 
servers.

For more information on WAIS, see either of the following documents from the 
public domain WAIS release:  overview.txt, or wais-concepts.txt.

3 Installation
Installation of MacWAIS is as easy as double-clicking on the distribution archive, 
MacWAIS1.29.SEA.  The archive contents may be stored anywhere you choose.
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4 A Quick Tour
Let’s find some information with MacWAIS!  For the sake of example, let’s find 
weather information for Austin (Texas).

First, launch MacWAIS.  Do this by double-clicking on the MacWAIS icon.  At this
stage, you’ll see an empty, unnamed Question Window and the Select Sources 
Dialog as shown in Figure 4.1.1.

Figure 4.1.1  MacWAIS – After Launching

Next we must find a Source that knows about weather.  This can be done by 
“asking” the Directory of Servers Source about weather.  First, we must 
locate the folder that contains WAIS Sources.  In this case, it happens to be the only
folder currently listed (i.e., wais-sources).  The contents of this folder may be 
listed by clicking on the Open button, or by pressing Return or Enter.  The contents 
of the wais-sources folder are shown in Figure 4.1.2.
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Figure 4.1.2  MacWAIS – After Locating wais-sources Folder

The Select Sources Dialog allows you to specify one or more Sources for use by 
this new, unnamed Question (i.e., of whom the Question will be asked).  It will be 
displayed every time you open a new Question.

Note
A default Source may be selected for use with new Questions via the File
Preferences… command.

To add Directory of Servers to the list of selected sources (located on the 
right side of the Select Sources Dialog) highlight it, by clicking the mouse on it 
once, and mark it for use with the current Question by clicking the Select button (or
pressing Return or Enter).

Tip
An unmarked Source may be marked for use by simply double-clicking 
on it.
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Figure 4.1.3 shows the Select Sources Dialog after selecting Directory of 
Servers.  (Notice the appearance of Directory of Servers in the list on the
right-hand side of the dialog entitled Selected Sources.  This indicates it has been 
selected for use by the current Question.)

Figure 4.1.3  MacWAIS – After Selecting Directory of Servers
To update the current Question with your Source selection, click the Done button.  
At this stage, the Question Window will be updated, as shown below in Figure 
4.1.4, indicating that the Directory of Servers Source was selected.  Notice 
also that the window title has changed – it now has a preceding bullet (‘•’) – 
indicating that the Question has been modified.

Note
The Selected Sources Popup, displayed by pressing the shadowed button 
with the downward-facing triangle, shows the names of all of the Sources
selected for use by this Question.
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Figure 4.1.4  MacWAIS – After Selecting Directory of Servers
To ask the selected Source about weather, simply type weather (which you’ll see 
echoed in the “Tell Me About:” box as shown in Figure 4.1.5), and click on the Ask
button (or press Return or Enter).

Figure 4.1.5  MacWAIS – After Typing weather

MacWAIS User Manual 11



12 MacWAIS User Manual
While MacWAIS is “asking” Directory of Servers about weather, you 
should see several status messages (in the Status box near the bottom of the 
Question Window) as shown in Figure 4.1.5, and the cursor should turn into a 
spinning globe.  After receiving a successful response, you should see several 
Result Documents (in this case three) in the “Information Found:” box as shown in 
Figure 4.1.5.

Figure 4.1.5  MacWAIS – After Searching Directory of Servers
To view the Result Document named weather.src (shown in Figure 4.1.5 as 
the first Document in the list) simply click on it once (which will highlight it and 
enable the View button) and click on the View button.

Tip
A Result Document may be viewed by simply double-clicking on it.

During the retrieval of this (or any) Document, you might see the Transfer Progress
Dialog shown in Figure 4.1.7a.  This Dialog is displayed depending on how long 
the transfer takes.  Short transfers, big or small, don’t bother displaying this Dialog.
Long transfers, on the other hand, do.  This Dialog indicates how the transfer is 
progressing by simply filling the bar according to the percentage of the Document 
that has been transferred.
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Figure 4.1.7a  Transfer Progress Dialog

For cases where the length of the document is not known (e.g., multi-type 
documents), you might see a textual version of the Transfer Progress Dialog as 
shown in Figure 4.1.7b.

Figure 4.1.7b  Textual Transfer Progress Dialog

Note
You can switch between the Textual and non-Textual (i.e., graphical bar) 
versions of the Transfer Progress Dialog by clicking the mouse anywhere
on the dialog.

After retrieving weather.src, you’ll see the Edit Source Dialog displaying 
information about weather.src as shown in Figure 4.1.8.

Figure 4.1.8  MacWAIS – Editing weather.src
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Notice that the only thing you can edit about this source is its name.

Check the “Use with current question” option (this will save you from having to 
explicitly select it later), and click the OK button.

At this stage, you’ll be prompted for where and under what name this Source 
should be saved via the standard Macintosh Save Dialog as shown in Figure 4.1.9.  
Initially, the name will be that specified in the Retrieved Source Dialog shown 
earlier in Figure 4.1.8.

Figure 4.1.9  MacWAIS – Saving weather.src

MacWAIS User Manual 14



15 MacWAIS User Manual
After dismissing the Save Dialog (by clicking on the Save button), notice that the 
Question Window has been updated to indicate that weather.src was selected, 
and that the previous “Tell Me About:” text is now highlighted as shown in Figure 
4.1.10.  (Highlighting the previous “Tell Me About:” text allows you to overwrite it
by simply typing new text.)

Figure 4.1.10  MacWAIS – After Selecting weather.src
To ask the newly selected Source about weather in Austin, simply type austin, 
and click on the Ask button.  While MacWAIS is “asking” weather.src about 
austin, you should again see several status messages, and the cursor should 
again turn into a spinning globe.

After receiving a successful response, you should see a single Result Document 
entitled Austin-TX.txt in the “Information Found:” box as shown in Figure 
4.1.11.
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Figure 4.1.11  MacWAIS – After Searching weather.src
To view this Document (Austin-TX.txt) simply double-click on it.  You’ll then
see a Text Document Window viewing it as shown in Figure 4.1.12.

Figure 4.1.12  MacWAIS – Viewing Austin-TX.txt
And there you have it – the MacWAIS Tour!
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5 MacWAIS Reference
The following sections describe each of the MacWAIS commands as they’re 
available either from menus, or directly from the Question Window.

The Apple Menu
The Apple Menu, shown in Figure 5.1.1, provides a single MacWAIS command for
displaying information about the MacWAIS application itself.

Figure 5.1.1  The Apple Menu

About MacWAIS… This command displays information about the MacWAIS application.  Among 
other things, it displays MacWAIS’s version.

MacWAIS User Manual 17
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The File Menu
The File Menu, shown in Figure 5.2.1, provides commands for opening new and 
previously saved Questions, cloning Questions, saving Questions and retrieved 
Text Documents, closing Question and Text Document Windows, editing printer 
setup, printing retrieved Text Documents, editing Preferences, and quitting 
MacWAIS.  The following paragraphs will describe each of these commands in 
more detail.

Figure 5.2.1  The File Menu

New Question This command opens a new Question Window.  If the “Default Source for New
Question” Preference has not been set, then the Select Sources Dialog will 
automatically appear.  Otherwise, the new Question will have its Source set to 
that specified by the “Default Source for New Question” Preference.  See the 
section entitled The Preferences Dialog for more details on the “Default Source
for New Question” Preference.

Clone Question This command opens a new Question Window whose contents are copied from
the current Question Window.

Tip
Clone Question may be invoked by pressing command-option-N.

Open Question… This command opens a Question that was previously saved to disk.  You will 
be presented with a standard open dialog box from which you can select the 
Question to be opened.

Close This command closes the currently active Question or Text Document 
Window.  If the currently active window is a Question Window that has been 
modified, and if the “Query to Save Dirty Questions and Sources” Preference 
is set (which is the default), then you’ll see a dialog box similar to the one 
shown in Figure 5.2.2.
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Figure 5.2.2  The Save Dirty Question/Source Dialog

This Dialog is giving you a chance to save (or not) a dirty Question before it is 
closed.

Tip
The Apr 18, 2021Close command may be invoked forcing the 
suppression of the Save Dirty Question/Source Dialog (independent of 
the “Query to Save Dirty Questions and Sources” Preference) by 
pressing command-option-W.

Save This command saves the contents of the currently active Question or Text 
Document Window.  If the currently active window has not been previously 
saved, then this command acts just like the Save As… command described 
below.

Save As… This command saves the contents of the currently active window to disk.  You 
will be presented with a standard save dialog that will allow you to specify the 
filename and folder in which the data should be saved.

Revert This command restores the contents of the currently active Question Window 
to those last saved to disk.

Note
Revert only applies to Question Windows that:
(a) have been modified since being opened, and
(b) represent previously saved Questions.

Page Setup… This command displays the standard Page Setup dialog that lets you edit the 
current printer setup parameters (e.g., specify the size of paper you’re 
printing on).

Print… This command prints the contents of the currently active Text Document 
Window.  You will be presented with a standard print dialog that will allow 
you to specify such things as the number of copies to print, page range, etc.

Preferences… This command lets you edit MacWAIS’s Preferences.  When you select this 
command, you’ll see a dialog box similar to the one shown later in Figure 
5.3.1.  The section entitled The Preferences Dialog will explain this dialog box 
in more detail.
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Quit This command quits the MacWAIS application.

Warning
Quitting MacWAIS will close all open windows.  See the Close 
command description above, and the “Query to Save Dirty Questions and
Sources” Preferences description below for more details.

Tip
All open windows may be closed and the application quit without query 
by pressing command-option-Q.
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The Preferences Dialog
The Preferences Dialog, shown in Figure 5.3.1, allows you to view and optionally 
edit MacWAIS Preferences.  It is displayed by selecting the Preferences… 
command from the File menu.

Figure 5.3.1  The Preferences Dialog

The “View WAIS Catalog as:” radio button gives you a choice of viewing WAIS 
Catalog Documents as either text, as a list of Documents, or to query the user to 
choose between the two (the default).  If it is viewed as text, then it is displayed in 
a separate Text Document Window (i.e., it is treated as any other WAIS Document 
of type TEXT).  If it is viewed as a list of Documents, then the WAIS Catalog is 
parsed and each of the Documents described therein (up to the Maximum Result 
Documents limit) is displayed as a Result Document in a new Question Window 
(cloned from the current Question Window) as if your query had resulted in each of
these Documents.  If the “View WAIS Catalog as:” Preference is set to Query 
(again, the default), then the user is asked, via the Multi-Type Dialog, to choose 
between “View As Text” and “View As Document List”.

Tip
To choose between Catalog Document viewing options (i.e., Text and 
Document Lists), press command-option when Viewing a Catalog 
Document.

The “Window At Startup:” radio button gives you a choice of the Question 
Window that is to be opened when the application is started.  If the“None” option 
is selected, which is the default, then no window will initially be opened.  If the 
“New” option is selected, then a new Question Window will initially be opened.  
(This is as if you had selected the “New Question” option from the File menu.  See 
the Section entitled The File Menu for more details.)  If the“Dialog” option is 
selected, then the Open Question dialog will be presented.  

MacWAIS User Manual 21



22 MacWAIS User Manual
(This is as if you had selected the “Open Question” option from the File menu.  
See the Section entitled The File Menu for more details.)

The “Maximum Result Documents” field specifies the maximum number of Result 
Documents that a Server is to return in response to a query.  This value, the default 
of which is 40, is applied to new Questions at the time that they’re initially opened.

If the “Apply MaxResDocs to All Open Questions” check box is checked, then all 
open Questions will be updated to reflect the “Maximum Result Documents” value.

The “Default Source for New Question” check box allows you to specify the 
default Source to be used by all subsequent new Questions (at the time they’re 
initially opened).  If unchecked, which is the default, then opening a new Question 
will immediately display the Select Sources Dialog shown later in Figure 5.9.1.  
Checking this box will immediately display the Select Sources Dialog giving you 
the opportunity to identify the Source that is to be designated the default Source for
use in new Questions.  See the section entitled The Select Sources Dialog for more 
details on selecting a Source.

After selecting an initial Source, the space to the right of the “Default Source for 
New Question” check box will be updated to display the name of the selected 
Source as exemplified in Figure 5.3.2.

Figure 5.3.2  The “Default Source for New Question” Check Box

If an initial Source is not selected from the Select Sources Dialog, then the “Source
for New Question” check box will remain unchecked.

Note
To change a selection you must click the “Default Source for New 
Question” check box twice.

The “Default Folder for saving Sources” check box allows you to specify the folder
in which newly created and retrieved Sources should automatically be saved.  If 
unchecked, which is the default, then attempting to save a newly defined or 
retrieved Source will require you to specify the folder in which the Source should 
be saved.  (This will occur every time you save a Source!)  Checking this box will 
immediately display the Select Folder Dialog, shown later in Figure 5.4.1, giving 
you the opportunity to identify the folder in which new and retrieved Sources 
should be saved.  See the section entitled The Select Folder Dialog for more details
on selecting a Sources folder.

After selecting a default folder, the space to the right of the “Default Folder for 
saving Sources” check box will be updated to display the name of the selected 
folder as exemplified in Figure 5.3.3.
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Figure 5.3.3  The “Default Folder for saving Sources” Check Box

Note
To change a selection you must click the “Default Folder for saving 
Sources” check box twice.

The “Default Folder for Temp Files” check box allows you to specify the folder in 
which documents, retrieved for the purposes of viewing, should automatically be 
saved.  (Use this Preference, for example, to store the MacWAIS application on a 
read-only Appleshare volume.)  If this Preference is unchecked, which is the 
default, then retrieved documents will be saved in the folder from which MacWAIS
was started.  Checking this box will immediately display the Select Folder Dialog, 
shown later in Figure 5.4.1, giving you the opportunity to identify the folder in 
which retrieved documents should be saved.  See the section entitled The Select 
Folder Dialog for more details on selecting a Temp Files folder.

After selecting a default folder, the space to the right of the “Default Folder for 
Temp Files” check box will be updated to display the name of the selected folder as
exemplified in Figure 5.3.4.

Figure 5.3.4  The “Default Folder for Temp Files” Check Box

Note
To change a selection you must click the “Default Folder for Temp Files”
check box twice.

The “Query to Save Dirty Questions and Sources” check box specifies how 
modifications to Question Windows (that have occurred since they were opened) 
and Sources (that have occurred since they were last saved to disk) should be 
handled.  If checked, then you’ll be asked, via the Save Dirty Source/Question 
Dialog shown earlier in Figure 5.2.2, whether or not the modifications should be 
saved before they are discarded.  Otherwise, modifications are automatically 
discarded.

The “Delete Search Results Immediately as Question is Modified” check box 
specifies when Result Documents (i.e., the fruits of a successful query) are 
discarded.  If checked, then they’re discarded the instant the Question is modified.  
Otherwise, they’re discarded only when either a new search is initiated or the 
Source(s) to be queried are changed.  By default, this option is not checked.

The “Character Transliteration” popup menu specifies how extended characters 
(i.e., characters >= 128) are mapped into Macintosh characters.  The default is 
“ISO->Mac” which is an ISO-1 Latin 
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mapping.  Other options include “fr->Mac” (French), “se->Mac” (Swedish), and so
on.  An option is selected by simply clicking on the popup menu and choosing the 
desired transliteration from the menu.

Note
Character Transliteration maps are stored as ‘cmap’ resources.  
Additional maps can be added by simply adding ‘cmap’ resources to 
either MacWAIS or its Preferences file.  ‘cmap’ resource number 128 is 
the default map (which is “ISO->Mac”).  Modifying this map (by either 
editing it directly or by renumbering resources) will effectively change 
MacWAIS’s default map.
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The Select Folder Dialog
The Select Folder Dialog, shown in Figure 5.4.1, allows you to select the folder in 
which new and retrieved sources will automatically be saved.  It is displayed by 
clicking either of the “Default Folder for saving Sources” or “Default Folder for 
Temp Files” check boxes in the Preferences Dialog shown in Figure 5.3.1.

Figure 5.4.1  The Select Folder Dialog

This dialog is identical to the standard save dialog except for the addition of the 
folder selection button at the bottom of the dialog.  In Figure 5.4.1, its title is 
Select: wais-sources.  Clicking on this button will select the currently 
listed folder as the default folder.  Note that the button’s title is updated with the 
name of the folder that is currently listed.
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The Edit Menu
The Edit Menu, shown in Figure 5.5.1, provides not only the standard Macintosh 
editing commands, but also three MacWAIS-specific commands:  Launchers…, 
Find…, and Find Again.  The following paragraphs will describe all of these 
commands in more detail.

Figure 5.5.1  The Edit Menu

Undo This command undoes the last text editing command.

Cut This command deletes the currently highlighted text and copies it to the paste 
buffer.  This command will be dimmed when either the currently active 
window is a Text Document Window or there is no currently highlighted text.

Copy This command copies the currently highlighted text to the paste buffer.  This 
command will be dimmed if there is no currently highlighted text.

Paste This command copies the contents of the paste buffer to the current text field.  
This command will be dimmed if either the currently active window is a Text 
Document Window or there is nothing in the paste buffer.

Clear This command deletes the currently highlighted text.  Note that it is not placed
in the paste buffer as with Cut.  This command will be dimmed if the currently
active window is a Text Document Window.

Launchers… This command allows you to edit MacWAIS’s Document Launcher 
information.  When you select this command, you’ll see a dialog box similar to 
the one shown later in Figure 5.6.1.  The section entitled The Edit Launchers 
Dialog will explain this dialog box in more detail.

Find… This command brings up the Find Dialog shown in Figure 5.5.2.

Figure 5.5.2  The Find Dialog

The Find Dialog allows you to specify words and/or phrases to be found in the 
current Text Document Window.  Text separated by <option-space> constitutes 
multiple search words.  For example, specifying 
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enterprise integration (i.e., the words “enterprise” and “integration” 
separated by a normal space) will find occurrences of the phrase “enterprise 
integration”.  However, specifying enterprise<option-
space>integration (i.e., the words “enterprise” and “integration” separated 
by <option-space>) will find occurrences of the individual words “enterprise” and 
“integration”.

Note
Searches are case-insensitive.

The “Use Keywords” button replaces the current Find text with the associated 
Question’s keywords parsed into words separated by <option-space> (which means
each keyword is interpreted as a separate search word).

Find Again This command continues searching through the current Text Document 
Window for the next occurrence of the previously specified search word(s).  If 
no search words have been previously specified, then this command acts just 
like the Find… command described above.
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The Edit Launchers Dialog
The Edit Launchers Dialog, shown in Figure 5.6.1, allows you to create, edit, and 
delete MacWAIS Launcher information.  It is displayed by selecting the 
Launchers… command from the Edit menu.

Figure 5.6.1  The Edit Launchers Dialog

Clicking on the Cancel button will discard all changes made.  Clicking on the OK 
button will permanently update MacWAIS’s Launcher information.

The Edit… and Delete buttons are dimmed until an existing Launcher is 
highlighted.  In this case, they are not dimmed because the TEXT Launcher is 
highlighted.

The Enable and Disable buttons are never both on, and their respective dimmed 
states reflect whether or not the highlighted Launcher is enabled.  In this case, the 
Disable button is dimmed because the highlighted Launcher, TEXT, is currently not
enabled for launching (as evidenced by its gray text).

When the New… command is selected (either by clicking on the New… button or 
by pressing -N), you’ll see the Edit Launcher Dialog shown later in Figure 5.7.1.⌘
It is initially blank.  See the section entitled The Edit Launcher Dialog for more 
details.

When the Edit… command is selected (either by double-clicking on an existing 
Launcher, clicking on the Edit… button, by pressing -E, or by option-double-⌘
clicking a Result Document in a Question Window), you’ll see the Edit Launcher 
Dialog shown later in Figure 5.7.1.  It will be initially populated with information 
from the currently highlighted Launcher.  See the section entitled The Edit 
Launcher Dialog for more details.

When the Delete command is selected (either by clicking on the Delete button, or 
by pressing -K), the currently highlighted Launcher is deleted.⌘
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When the Enable command is selected (either by clicking on the Enable button, or 
by pressing -?), the currently highlighted Launcher is enabled for launching.  ⌘
Notice that the Launcher’s text changes from gray to black.

When the Disable command is selected (either by clicking on the Disable button, 
or by pressing -D), the currently highlighted Launcher is disabled for launching. ⌘
Notice that the Launcher’s text changes from black to gray.

Tip
You may toggle a Launcher’s enabled state by option-double-clicking on 
it.
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The Edit Launcher Dialog
The Edit Launcher Dialog, shown in Figure 5.7.1, allows you to define new 
Document launching information.  It is displayed by clicking on either the New… 
or Edit… buttons in the Edit Launchers Dialog,, shown earlier in Figure 5.6.1, or 
by option-double-clicking on a Result Document in a Question Window shown 
later in Figure 5.13.1.

Specifically, the Edit Launcher Dialog lets you define:

• the mapping between WAIS Documents and Macintosh files (which 
enables MacWAIS to save WAIS Documents), and

• the mapping between WAIS Documents and Macintosh applications 
(which enables MacWAIS to launch applications to view WAIS 
Documents).

Figure 5.7.1  The Edit Launcher Dialog

The WAIS Type field specifies, as the name implies, the WAIS Document type (in 
this case TEXT).

The Description field is a user-specified description of this Document type (in this 
case Text Files).

The Type and Creator fields specify the Macintosh file type and creator that 
correspond to the specified WAIS type (in this case TEXT and ttxt, respectively).
When a WAIS Document is retrieved and saved, the resulting Macintosh file that is
created will have its type and creator attributes specified by these fields.  For 
example, from the information shown above in Figure 5.7.1, a WAIS Document of 
type TEXT that is retrieved and saved will yield a Macintosh file of type TEXT and 
creator ttxt.(i.e., a TeachText file)

The “Choose Example…” button allows you to specify the Type and Creator fields 
by selecting an existing Macintosh file from a standard file open dialog box.
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The “With Translation” popup specifies the type of translation that will be applied 
to the WAIS Document before it is processed or saved.  Current choices include 
None and MacBinary.

The Signature field specifies the Macintosh application that will be launched to 
process this file.  When the Creator field, above, is specified, the Signature field, if 
blank, is initialized to this value.

The “Choose Application…” button allows you to specify this field by choosing 
the desired Macintosh application from a standard file open dialog box.

The “Don’t Launch” check box indicates whether or not the Launcher is enabled.  
If checked, then the Launcher is not enabled; thus, MacWAIS will not launch the 
specified application when a WAIS Document of this type is retrieved (i.e., this 
type of Document can not be viewed).  Note, however, that even though the 
Launcher may be disabled, the Document can still be saved.
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The Sources Menu
The Sources Menu, shown in Figure 5.8.1, provides commands for defining new 
Sources, editing Sources, and selecting Sources for use with the currently active 
Question  The following paragraphs will describe all of these commands in more 
detail.

Figure 5.8.1  The Sources Menu

New… This command allows you to define a new Source.  When you select this 
command, you’ll see a dialog box similar to the one shown later in Figure 
5.9.1.  It is initially blank except for the Name field which is set to unnamed 
and the Port field which is set to 210.  The section entitled The Edit Source 
Dialog will explain this dialog in more detail.

Edit… This command allows you to edit an existing Source.  When you select this 
command, you’ll see the Select Source Dialog shown in Figure 5.8.2.

Figure 5.8.2  The Select Source Dialog

This dialog allows you to identify the Source that is to be edited.  It is identical to 
the standard open dialog except for the addition of the “Show All Files” check box 
at the bottom of the dialog.  With this box unchecked, only Source files created by 
MacWAIS will be shown.  Checking this box will allow all files to be listed.  (This 
is a good way for utilizing Source files from WAIStation or files that were ftp’d 
and didn’t assume the proper creator.)

Once a file is selected, you’ll see a dialog box similar to the one shown later in 
Figure 5.9.1.  It is initially populated with information from the selected Source.  
See the section entitled The Edit Source Dialog for more details.

Select… This command allows you to select Sources for use by the currently active 
Question.  When you select this command, you’ll see a dialog box similar to 
the one shown later in Figure 5.10.1.  The section entitled The Select Sources 
Dialog will explain this dialog box in more detail.
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Note
If there is no currently active Question then the Select… command will 
be disabled.
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The Edit Source Dialog
The Edit Source Dialog, shown in Figure 5.9.1, allows you to edit MacWAIS 
Source information.  It is displayed by selecting the New… or Edit… command in 
the Sources Menu, shown earlier in Figure 5.8.1, or by retrieving a Source, as 
shown in Figure 4.1.8.

Figure 5.9.1  The Edit Source Dialog

The Name field specifies the name of the Macintosh file in which the Source 
information will be stored.  Existing Sources that are being edited are saved in the 
folder from which the Source was originally selected (even if the Source is 
renamed).  New Sources, however, are saved in the folder specified by the “Default
Folder for saving Sources” Preference.  If this Preference is unspecified, then you 
will see the standard Macintosh save dialog which offers you the opportunity to 
specify the name and folder in which the Source should be saved.

Note
In the case of retrieved Sources, only the Name field is editable.  
Otherwise, all fields are editable.

The Database field specifies the Server-relative (path)name of the WAIS database.

The Host field specifies the hostname (either a DNS style name or an IP address) 
on which the Server is running.

The Port field specifies the port number on which the Server is “listening.”  The 
default is 210.

Note
Leading and trailing blanks are automatically trimmed from the Host and
Port fields.

MacWAIS User Manual 34



35 MacWAIS User Manual
The Description field is a textual description of the information offered by this 
Source.

The “Use with current question” check box, if checked, specifies that the currently 
active Question should be updated to use this Source exclusively.  This option is 
only available if there is a currently active Question.
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The Select Sources Dialog
The Select Sources Dialog, shown in Figure 5.10.1, allows you to select Sources 
for use by the currently active Question.  It is displayed by selecting the Select… 
command from the Sources menu.

Figure 5.10.1  The Select Sources Dialog

This dialog is actually a standard open dialog with the following exceptions:

• Addition of Selected Sources list
• Addition of Select and Remove buttons
• Addition of “Show All Files” check box
• Addition of “View Source…” button
• Modification of Open button (name changed from “Open” to “>> 

Select >>”)
A Source is selected for use by the currently active Question by highlighting it in 
the file system list and clicking on the Select button (or pressing Return or Enter).  
A Source may be included in the selection list only once.

A Source is deselected for use by highlighting it in the Selected Sources list and 
clicking on the Remove button (or pressing Delete).  Notice that the Remove 
button remains dimmed until a Source in the Selected Sources list is highlighted.

A Source is viewed by highlighting it in the Selected Sources list and clicking on 
the View Source button.  The View Source Dialog is identical to the Edit Source 
Dialog, shown in Figure 5.9.1, except none of the fields are editable.

Select Sources Tips:
• You may scroll to sections of the file system list by typing the first letter of 

a Source.  The first Source whose name begins with the specified letter will
be displayed.  MacWAIS will attempt to center this Source in the list 
display.
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• You may scroll through the list using the arrow up/down keys.
• You may select a Source by double-clicking on it in the file system list.  

This selection will be appended to the current Selected Sources list.
• You may uniquely select a Source by shift-double-clicking on it in the file 

system list (or by highlighting it in the file system list and shift-clicking on 
the Select button, or by pressing either shift-Return or shift-Enter).

• You may deselect a Source by double-clicking on it in the Selected Sources
list (or by highlighting it and pressing Delete).
• You may view a Source by option-double-clicking on it in either 
list.
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The Text Menu
The Text Menu, shown in Figure 5.11.1, provides  a single command, Add Section 
As Feedback.  The following paragraph will describe this command in more detail.

Figure 5.11.1  The Text Menu

Add Section As Feedback This command incorporates the line(s) currently highlighted in the front-most 
Text Document Window as Relevance Feedback in its associated Question.  If 
the current selection has already been incorporated as Relevance Feedback, or
if there is no current selection, then this item will be dimmed.

Note
If the currently active window is not a Text Document Window, then the 
Text Menu, itself, will be dimmed.
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The Windows Menu
The Windows Menu, shown in Figure 5.12.1, allows you to select any of the 
currently open windows.  It is populated with one static entry, MacWAIS Help, 
and dynamically populated with one entry for each of the Question and Text 
Document Windows that are currently open.  The following paragraph will describe
the MacWAIS Help command.

Figure 5.12.1  The Windows Menu

MacWAIS Help This command is not currently implemented.

A numeric command-key is defined for each of the dynamic menu entries.  Their 
number is based on the order in which they were opened.  The first window is 
assigned -1 (command-one ), the second -2, and so on.  As windows are ⌘ ⌘
closed, their numbers are reused, but the list is not compacted.
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The Question Window
The Question Window, shown in Figure 5.13.1, is the main user interface 
component in MacWAIS.  It allows you to specify and direct queries, and operate 
on the “fruits” of successful queries (i.e., Result Documents).

Clicking this button 
initiates the specified 
query

Free-form text describing 
the information to be 
found

Status information

Pressing (and holding) this 
button displays the currently 
selected Sources

Result Documents

Clicking this button 
views the selected 
Document

Clicking this button 
saves the selected 
Document

Clicking this button adds the 
selected Result Document (in its 
entirety) as Relevance Feedback

Documents (or 
Document portions) 
incorporated as 
Relevance Feedback

Clicking this button 
deletes the selected 
Feedback  Document

Name of currently selected 
Source.  (If more than 1, then 
displays the number of Sources.)

Bullet ('•') indicates 
Question has been 
modified

Figure 5.13.1  The Question Window

Asking a Question is really quite simple.  First, open a Question Window by 
selecting either New Window or Open Window… from the File Menu (or by 
pressing -N or -O, respectively).  Next, specify the free-form text comprising ⌘ ⌘
the query (e.g., weather, as shown above).  Then, specify the Source(s) of whom 
this Question should be asked by selecting the Select… command from the Sources
Menu (or by pressing -E).  Finally, click on the Ask button (or press Enter or ⌘
Return).
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Documents returned as a result of the Query (or Result Documents) may be viewed 
or saved by first highlighting the desired Document and then clicking on the 
appropriate button.

Tip
A Result Document may be viewed by simply double-clicking on it.

For multi-type documents, the desired type must be designated before the 
document can be retrieved, or it’s corresponding Launcher information can be 
edited.  Document type selections are made from the Multi-Type Dialog shown 
later in Figure 5.14.1.  For more information regarding this dialog, see the section 
entitled The Multi-Type Dialog.

If the Save button remains dimmed after highlighting a Result Document, then 
MacWAIS does not have the necessary information to map this Document to a 
Macintosh file (i.e., it doesn’t know the kind of Macintosh file to create in which to
store the Document’s data when it is retrieved).  This information may be defined 
via the Edit Launcher Dialog which is displayed by first selecting Launchers… 
from the Edit Menu and then clicking on the New… button in the Edit Launchers 
Dialog.  See the section entitled The Edit Launcher Dialog for more details on 
defining WAIS-to-Macintosh file mapping information.

Tip
Launcher information may be edited by option-double-clicking on a 
Result Document.  This has the benefit of extracting the WAIS type from
the selected document.

If the View button remains dimmed after highlighting a Result Document, then one 
of three things is true.  Either (a) the Launcher information corresponding to this 
WAIS type has not been defined, or (b) the Launcher has been defined but is 
currently disabled, or (c) you’re running MacWAIS on a System 6 machine.

In case (a), you must simply define the necessary WAIS-to-Macintosh file mapping
information.  See the section entitled The Edit Launcher Dialog for more details.  
(Remember that you can option-double-click a Document to edit its Launcher 
information.)

In case (b), you must simply enable the Launcher that’s already defined.  See the 
section entitled The Edit Launcher Dialog for details on enabling Launchers.  
(Remember that you can option-double-click a Document to edit its Launcher 
information.)

In case (c), System 6 doesn’t provide application launching.  To use this feature, 
you must upgrade to System 7.
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Questions may be refined by incorporating Documents  as Relevance Feedback.  
This is done by highlighting a Result Document and clicking on the Add Ref 
button.

Tip
A Result Document can be added as Relevance Feedback by shift-
double-clicking on it.

After a Document is added as Relevance Feedback, the Add Ref button is dimmed.

Note
Only Documents of WAIS type TEXT can be added as Relevance 
Feedback.  Thus, the Add Ref button will be dimmed if either no Result 
Document is highlighted, or the highlighted Result Document is not of 
WAIS type TEXT.

Document portions can be added as Relevance Feedback from Text Document 
Windows.  See the section entitled The Text Menu for more details.
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The Multi-Type Dialog
The Multi-Type Dialog, shown below in Figure 5.14.1, applies only to multi-type 
documents (i.e., single documents with multiple types).  It allows you to select one 
of the available types for either document retrieval or launcher editing purposes.  It 
will appear when attempting to view, save, or edit the launchers of a multi-type 
document.

Figure 5.14.1  The Select Type Dialog

Notice that the OK button remains dim until an item is highlighted.

An item may be selected by highlighting it (by clicking the mouse on it once), and 
clicking on the OK button (or pressing Return or Enter).

Tip
A Multi-Type Dialog item may be selected by simply double-clicking on 
it.
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